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GMPLS UNI
GeneralizedMultiprotocol Label SwitchingUser Network Interface (GMPLSUNI) is a control plane technology
that

• enables packet networks to interact directly with the optical transport control plane,

• coordinates packet network resource requirements with the optical transport network, and

• uses open standards to optimize network resource use across packet and optical domains.

Packet and optical integration

As cloud services become central to business operations, packet and optical network services must evolve to
be more efficient and dynamic. Closer integration of packet and optical networks is critical, especially in the
control plane. GMPLS UNI is a key enabling technology that supports this integration.

Channel spacing

The Dense Wavelength Division Multiplexing (DWDM) grid in the C-band (1530–1569 nm) of the optical
spectrum is divided into multiple channels so that each channel can carry traffic independently. The number
of channels available from the DWDM grid depends on the channel spacing: lower channel spacing yields
more channels, and higher channel spacing yields fewer channels.

GMPLS supports two types of channel spacing.

• Fixed grid channel spacing: The channel spacing is fixed at 50 GHz and supports 100 Gbps and 200
Gbps traffic.

• Flexible grid channel spacing: The channel spacing is 6.25 GHz and supports all data rates. The channels
are divided into finer slices so that the channel width can be defined as a multiple of these slices to fit
the data bandwidth requirement.

NCS 1004 supports only flexible grid channel spacing.

The neighbor flexi-grid-capable command enables GMPLS UNI flexible grid channel spacing. This
command is run during the LMP configuration.
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GMPLS UNI tunnels
GMPLS UNI tunnels are end-to-end optical paths between two NCS 1004 nodes that

• connects two nodes,

• efficiently uses the Dense Wavelength Division Multiplexing (DWDM) grid with minimal wastage of
spectral bandwidth, and

• carries mixed bit-rate or mixed modulation data in a flexible grid using different channel widths.

To address common packet and optical network requirements, you create a tunnel between two NCS 1004
nodes to carry traffic by using GMPLS UNI technology, as shown in the following figure.

Figure 1: GMPLS UNI reference model

UNI-C is the client, packet, or router node, for example, an NCS 1004 node. UNI-N is the network or optical
node, for example, an NCS 2000 node.

A Link Management Protocol (LMP) link is created to establish connectivity between an NCS 2000 node and
an NCS 1004 node. The tunnel is then created between the trunk interfaces of the source and destination NCS
1004 nodes to carry traffic. When the tunnel is created between NCS 1004 nodes, a circuit is internally created
between the NCS 2000 nodes to perform path computation, restoration, and reversion functions.

The tunnel can be created between the source and destination NCS 1004 nodes without involving NCS 2000
nodes in the middle. However, restoration and reversion capabilities are provided only by NCS 2000 nodes
that use GMPLS UNI.

Licensing and configuration prerequisites for GMPLS UNI tunnels
Ensure that all necessary software packages, licenses, network reachability, and operational port conditions
aremet onNCS 1002, NCS 1004, andNCS 2000 nodes before creating a tunnel usingGeneralizedMultiprotocol
Label Switching User Network Interface (GMPLSUNI), enabling successful tunnel deployment and operation.

Before you create a tunnel by using GMPLS UNI, ensure that the following prerequisites are met.

• The NCS 1004 node has both the MPLS and MPLS-TE packages installed. The package names are
ncs1004-mpls and ncs1004-mpls-te-rsvp.

• The NCS 2000 node has a valid license for ROADMandWavelength Switched Optical Network (WSON)
support.

• The management IP addresses of the NCS 1004 and NCS 2000 nodes are reachable.

• The administrative state of the trunk port of the optics controller on the NCS 1004 node is not in the
shutdown state.
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Limitations for a GMPLS UNI tunnel
This reference enables you to accurately identify the supported trunk port types and software release restrictions
for GMPLS UNI tunnels on NCS 1002 nodes, ensuring compliant and optimized tunnel configuration.

The following limitations apply when you create a GMPLS UNI tunnel.

Configuration workflow for a GMPLS UNI tunnel

Summary

Creating a GMPLS UNI tunnel involves the following actors.

• NCS 2000 node (UNI-N): Provides the optical transport network and runs the LinkManagement Protocol
(LMP) endpoint, alien wavelength, and ifindex provisioning.

• NCS 1004 node (UNI-C): Acts as the client router that runs LMP, Resource Reservation Protocol (RSVP),
and the MPLS traffic-engineering tunnel toward the destination node.

You complete the NCS 2000 node configuration first, then configure the source and destination NCS 1004
nodes to bring up the tunnel.

Workflow

These stages describe the GMPLS UNI tunnel configuration workflow.

1. On the NCS 2000 node, perform the following configurations:

• Configure LMP and alien wavelength on the NCS 2000 node by using CTC.

• Retrieve ifindex from the NCS 2000 node.

2. On the NCS 1004 node, perform the following configurations:

• Configure LMP on the Cisco NCS 1002 or NCS 1004 node.

• Configure the MPLS tunnel on the NCS 1002 or NCS 1004 node.

• Configure RSVP on the NCS 1002 or NCS 1004 node.

Result

The GMPLS UNI tunnel is established between the source and destination NCS 1004 nodes, with the optical
path computed by the NCS 2000 nodes.

Configure an LMP link and Alien Wavelength on an NCS 2000 node using CTC
Establish connectivity and enable advanced opUse this task to set up a static LMP link between a Cisco NCS
2000 node and either an NCS 1004 node. The CTC LMP creation wizard enables you to select source and
destination endpoints, configure optical parameters, and set alien wavelength options. tical parameters and
alien wavelength configurations for signaled numbered circuits between Cisco optical network nodes.

Use this task to set up a static LMP link between a Cisco NCS 2000 node and either an NCS 1002 or NCS
1004 node. The CTC LMP creation wizard enables you to select source and destination endpoints, configure
optical parameters, and set alien wavelength options.
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Procedure

Step 1 From the View menu, choose Go to Network View.
Step 2 Click the Provisioning > LMP tabs.
Step 3 Click Create.

The LMP Creation window appears.

Step 4 Click Signaled in the Router Not Managed by CTC area.

A wizard appears with the following options:

LMP Origination, LMP Termination, Optical Parameters, and Alien Wavelength

Step 5 In the LMP Origination screen of the wizard, provision these parameters:

• From the Originating Node drop-down list, choose the source node of the LMP.

If the source node is Cisco NCS 1004, the destination node must be MSTP, and the other way round.

• From the Local Interfaces drop-down list, choose an available interface.

• Choose the Type, Shelf, Slot, and Port for Ingress Port Selection and Egress Port Selection.

• Choose Numbered interface.

• Enter the IP address of the source node in the Interface IP field.

• Set the mode of revertive restoration to either UNI-C or UNI-N. If the mode is set to UNI-C, the reversion of the
circuit from the restored path to the original path is initiated by the UNI client that is connected to NCS 1004. If the
mode is set to UNI-N, the reversion of the circuit is initiated by the DWDM network and can either be a manual
revert or an auto revert.

• Enter the RSVP signaling interval and RSVP signaling missed values in the respective fields.

• Click Next.

Step 6 In the LMP Termination screen of the wizard, provision these parameters:

• From the Terminating Node drop-down list, choose the destination node of the LMP; for example, MSTP node.

• From the Rx Port Selection area, perform the following.

• Choose the card type from the Type drop-down list.

• Choose a shelf from the Shelf drop-down list.

• Choose a source slot from the Slot drop-down list

• Choose a port from the Port drop-down list.

• From the Tx Port Selection area, perform the following.

• Choose the card type from the Type drop-down list.

• Choose a shelf from the Shelf drop-down list.
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• Choose a destination slot from the Slot drop-down list.

• Choose a port from the Port drop-down list

• Enter the IP address of the destination node in the Interface IP field.

• Set the mode of revertive restoration to either UNI-C or UNI-N. If the mode is set to UNI-C, the reversion of the
circuit from the restored path to the original path is initiated by the UNI client that is connected. If the mode is set
to UNI-N, the reversion of the circuit is initiated by the DWDM network and can be either a manual revert or an
auto revert.

• Enter the remote Ifindex of NCS 1004 node (in decimals) in the Remote If Index field.

• Click Next.

Step 7 In the Optical Parameters screen of the wizard, provision these parameters:

• Allow Regeneration—When checked, the computed path traverses through the regeneration site only if the optical
validation is not satisfied. You can regenerate a circuit that is created from the UNI interface. If a transparent path
is feasible, the regenerator is not used.

• UNI State—Choose Enable or Disable from the UNI State drop-down list.

The Enable state is used to configure the UNI interface for the circuits to pass through, between the router and the
DWDM node. In the Disable state, the interface is configured but not active, and so the circuit activation is rejected.
When the status is changed from Enable to Disable, all active circuits on the interface are deleted.

• Description—Enter the description of the UNI interface. The description can be up to 256 characters.

• Label—Enter an alphanumeric string. This label is a unique circuit identifier.

• Validation—Sets the optical validation mode.

• Full—The circuit is created when the circuit validation result is greater than or equal to the acceptance threshold
value.

• None—The circuit is created without considering the acceptance threshold value. The Opt Valid column in the
Circuits tab displays the value as Not Valid.

• Inherited—The restoration circuit inherits the validation and acceptance threshold values from the primary
circuit.

• Acceptance threshold—Sets the acceptance threshold value for the GMPLS circuit. The circuit is created if the
actual acceptance threshold value is greater than, or equal to, the value set in this field.

• Green—Indicates that the channel failure risk is 0%.

• Yellow—Indicates that the channel failure risk is between 0% and 16%.

• Orange—Indicates that the channel failure risk is between 16% and 50%.

• Red—Indicates that the channel failure risk is greater that 50%.

• Restoration—Check this check box to enable the restoration of the GMPLS circuits on the UNI interface.

• Revert—Check this check box to enable the revert of the GMPLS circuits on the UNI interface.
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• Auto Revert—Click this radio button to automatically revert the circuit from the restored path to the original path
after the failure is fixed, WSON alarms are acknowledged, and the soak time expires.

• Manual Revert—Click this radio button to manually revert the circuit from the restored path to the original path
after the failure is fixed, the WSON alarms are acknowledged, and the soak time expires.

• Soak Time—Enter the time (in hours, minutes, and seconds) in the Soak Time field that the circuit on the restored
path waits before moving to the original path after the failure is fixed. The circuit reverts to the original path after
the soak time expires. The soak time must be set only if both the Restoration and Revert check boxes are checked.

Step 8 Click Next.
Step 9 In the Alien wavelength screen of the wizard, provision these parameters.

• From the Alien Wavelength drop-down list, choose the alien wavelength class.

• From the Trunk Selection drop-down list, choose 100G, 200G, or 250G.

• From the FEC drop-down list, choose a valid value for forward error correction (FEC) mode. If an invalid FEC
value is chosen, LMP link is created; however, the circuit creation fails.

• Click Finish to create an LMP link.

The LMP link with specified optical parameters and alien wavelength settings is created and listed in CTC,
ready for signaled numbered circuit provisioning.

Retrieve ifindex from the NCS 2000 node
You can retrieve the ifindex value of all the LMP ports of the NCS 2000 node by using the Cisco Transport
Controller (CTC) or the TL1 interface. Use this value in the neighbor interface-id unnumbered command
during the LMP configuration on the NCS 1004 node.

Procedure

Retrieve the ifindex by using either CTC or TL1.

• To use CTC, click the Provisioning >LMP tab and read the ifindex value, in decimal format, under theOriginating
Interface Index column.

• To use TL1, log in to the TL1 interface and run the rtrv-unicfg ::all:1; command. The command returns the ifindex
of all the LMP ports of the NCS 2000 node in hexadecimal format. Convert the value to decimal format before you
use it as the remote ifindex of the NCS 1004 node.

The following sample TL1 output shows the ifindex of two LMP ports.

Example:
PSLINE-81-1-9-RX:PSLINE-81-1-9-TX,10.77.142.92,3.3.3.4,3.3.3.3,0.0.0.0,VALMODE=NONE,ADMINSTATE=UP,
RESTTYPE=REVERT,USPWROFS=0.0,
DSPWROFS=0.0,ALLOWREGEN=NO,UNICTRLMODE=CLIENT,REVERTMODE=MANUAL,SOAK=00-01-00,
RESTVALMODE=NONE,TERMINTFDX=0,ORIGINTFIDX=7f000d12,NUMBERED=TRUE,UNIMODE=GMPLS

PSLINE-81-1-10-RX:PSLINE-81-1-10-TX,10.77.142.92,4.4.4.4,4.4.4.3,0.0.0.0,VALMODE=NONE,ADMINSTATE=UP,
RESTTYPE=REVERT,USPWROFS=0.0,DSPWROFS=0.0,ALLOWREGEN=NO,UNICTRLMODE=CLIENT,
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REVERTMODE=MANUAL,SOAK=00-01-00,RESTVALMODE=NONE,TERMINTFDX=0,
ORIGINTFIDX=7f000d14,NUMBERED=TRUE,UNIMODE=GMPLS

In the sample output, the ifindex of port 81-1-9 is 7f000d12 in hexadecimal and 2130709778 in decimal. The ifindex
of port 81-1-10 is 7f000d14 in hexadecimal and 2130709780 in decimal.

Configure LMP on Cisco NCS 1004 node
Set up LMP parameters to enable proper communication and management between optical network devices
on a Cisco NCS 1004 node.

Use this task to configure trunk optics, neighbor link parameters, flexible grid capabilities, and associated
identifiers for numbered or unnumbered circuits. This configuration ensures seamless interoperability between
Cisco NCS 1004 and NCS 2000 nodes.

Procedure

Step 1 Enter the LMP GMPLS optical UNI configuration mode.

Example:
RP/0/RP0/CPU0:ios#configure
RP/0/RP0/CPU0:ios(config)#lmp
RP/0/RP0/CPU0:ios(config-lmp)#gmpls optical-uni

Step 2 Specify the trunk optics controller.

Example:
RP/0/RP0/CPU0:ios(config-lmp-gmpls-uni)#controller optics 0/1/0/0

Step 3 Configure the LMP neighbor name.

Example:

RP/0/RP0/CPU0:ios(config-lmp-gmpls-cntl)#neighbor VEGA2K-Site-2_47

Step 4 Enable GMPLS UNI flexible grid channel spacing.

Example:
RP/0/RP0/CPU0:ios(config-lmp-gmpls-cntl)#neighbor flexi-grid-capable

Step 5 Specify the neighbor optical interface ID, which is the ifindex value of the LMP port of the NCS 2000 node in decimal
format.

Example:
RP/0/RP0/CPU0:ios(config-lmp-gmpls-cntl)#neighbor interface-id unnumbered 19

To retrieve the ifindex value, see Retrieve ifindex from the NCS 2000 node.

Step 6 Set the IPCC mode to routed.

Example:
RP/0/RP0/CPU0:ios(config-lmp-gmpls-uni)#ipcc routed

Step 7 Specify the neighbor router ID for GMPLS UNI, and commit the configuration.
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Example:
RP/0/RP0/CPU0:ios(config-lmp-gmpls-cntl)# router-id ipv4 unicast 192.168.2.1
RP/0/RP0/CPU0:ios(config-lmp-gmpls-cntl)#commit

Step 8 View the configuration.

Example:
show running-config lmp
lmp
gmpls optical-uni
controller optics0/0/0/13
neighbor NCS1K
neighbor link-id ipv4 unicast 192.168.2.3
neighbor flexi-grid-capable
neighbor interface-id unnumbered 19
link-id ipv4 unicast 192.168.2.4
!
neighbor NCS1K
ipcc routed
router-id ipv4 unicast 192.168.2.1
!
router-id ipv4 unicast 192.168.2.2
!

!

Mon Jul 1 14:42:46.856 IST
lmp
gmpls optical-uni
controller Optics0/0/0/0
neighbor ncs1k
neighbor link-id ipv4 unicast 10.1.1.1
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130706976
link-id ipv4 unicast 10.0.1.1
!
controller Optics0/0/0/1
neighbor ncs1k
neighbor link-id ipv4 unicast 10.1.3.3
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130707232
link-id ipv4 unicast 10.0.3.3
!
controller Optics0/1/0/0
neighbor ncs1k
neighbor link-id ipv4 unicast 10.1.4.4
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130706964
link-id ipv4 unicast 10.0.4.4
!
controller Optics0/1/0/1
neighbor ncs1k
neighbor link-id ipv4 unicast 10.1.5.5
neighbor flexi-grid-capable
neighbor interface-id unnumbered 2130706966
link-id ipv4 unicast 10.0.5.5
!
neighbor ncs1k
ipcc routed
router-id ipv4 unicast 10.127.60.48
!
router-id ipv4 unicast 10.105.57.101
!
!
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show mpls traffic-eng tunnels optical-uni brief
Wed Sep 22 17:08:13.132 IST

TUNNEL NAME DESTINATION STATUS STATE
GMPLS-UNI-Optics0/3/0/1 10.24.1.1 up up
GMPLS-UNI-Optics0/0/0/1 10.34.1.1 up up

Displayed 2 (of 2) heads, 0 (of 0) midpoints, 0 (of 0) tails
Displayed 2 up, 0 down, 0 recovering, 0 recovered heads

commit

The Cisco NCS 1004 node is configured with the required LMP parameters for optical trunk and neighbor
link management, supporting both numbered and unnumbered circuits.

Configure RSVP on the NCS 1004 node
You configure the Resource Reservation Protocol (RSVP) with appropriate signaling timers on the source
and destination NCS 1004 nodes of the tunnel.

Procedure

Step 1 Enter the global configuration mode and the RSVP configuration mode.

Example:
RP/0/RP0/CPU0:ios#configure
RP/0/RP0/CPU0:ios(config)#rsvp

Step 2 Specify the optics controller.

Example:
RP/0/RP0/CPU0:ios(config-rsvp)#controller optics 0/0/0/6

Step 3 Set the out-of-band signaling refresh interval, in seconds.

Example:
RP/0/RP0/CPU0:ios(config-rsvp-cntl)#signalling refresh out-of-band interval 3600

Step 4 Set the maximum number of missed out-of-band signaling refreshes that are allowed before the session is removed, and
commit.

Example:
RP/0/RP0/CPU0:ios(config-rsvp-cntl)#signalling refresh out-of-band missed 24
RP/0/RP0/CPU0:ios(config-rsvp-cntl)#commit

signalling refresh out-of-band missed mis-count

What to do next

The following sample shows the RSVP configuration on the source NCS 1004 node.
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GMPLS UNI tunnel, RSVP, and LMP configuration commands and sample
outputs

Use the show commands in the following table to verify the GMPLS UNI tunnel, RSVP, and LMP
configuration.

Table 1: Show commands

DescriptionShow command

Displays detailed GMPLS information of a specific
optics controller.

show mpls traffic-eng link-management optical-uni
controller optics

Displays detailedGMPLS information of all the optics
controllers.

show mpls traffic-eng link-management optical-uni

Displays information about tunnels.show mpls traffic-eng tunnels

Displays detailedGMPLS information of all the optics
controllers in tabular format.

show mpls traffic-eng link-management optical-uni
tabular

Displays information about all the tunnels in tabular
format.

show mpls traffic-eng tunnels tabular

Verifies the LMP configuration and state.show lmp gmpls optical-uni

Displays information about RSVP neighbors.show rsvp neighbors

Sample outputs

This sample out of the commnad show mpls traffic-eng link-management optical-uni controller optics
command displays detailed GMPLS information of a specific optics controller.
Mon Jul 1 20:05:27.209 IST
Optical interface: Optics0/0/0/0
Overview:
IM state: Up
Child interface: : IM state Unknown
OLM/LMP state: Up
Optical tunnel state: up

Connection:
Tunnel role: Tail
Tunnel-id: 15, LSP-id 3, Extended tunnel-id 10.105.57.100
Tunnel source: 10.105.57.100, destination: 11.1.1.1
Optical router-ids: Local: 10.105.57.101, Remote: 10.127.60.48
Label source: UNI-N
Upstream label:
Optical label:
Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number : -277

Downstream label:
Optical label:
Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0

GMPLS UNI for Packet and Optical Integration
10

GMPLS UNI for Packet and Optical Integration
GMPLS UNI tunnel, RSVP, and LMP configuration commands and sample outputs



Channel Number : -277
SRLG discovery: Disabled
SRLG announcement: None
Switching Type: lsc
MTU: 9212

Admission Control:
Upstream: Admitted (LSP ID: 3)
Downstream: Admitted (LSP ID: 3)

OLM/LMP adjacency information:
Adjacency status: Up
Local:
node ID: 10.105.57.101
link interface ID: 10
link ID: 11.1.1.1

Neighbor:
node ID: 10.127.60.48 (VEGA2K-Site-3_48)
link interface ID: 2130706976
link ID: 10.1.1.1
IPCC: Routed to 10.127.60.48

Optical capabilities:
Controller type: DWDM
Channel spacing: 6.25 GHz
Default channel: 0
784 supported channels:
-303, -302, -301, -300, -299, -298, -297, -296
-295, -294, -293, -292, -291, -290, -289, -288
-287, -286, -285, -284, -283, -282, -281, -280
-279, -278, -277, -276, -275, -274, -273, -272
-271, -270, -269, -268, -267, -266, -265, -264
-263, -262, -261, -260, -259, -258, -257, -256
-255, -254, -253, -252, -251, -250, -249, -248
-247, -246, -245, -244, -243, -242, -241, -240
-239, -238, -237, -236, -235, -234, -233, -232
-231, -230, -229, -228, -227, -226, -225, -224
-223, -222, -221, -220, -219, -218, -217, -216
-215, -214, -213, -212, -211, -210, -209, -208
-207, -206, -205, -204, -203, -202, -201, -200
-199, -198, -197, -196, -195, -194, -193, -192
-191, -190, -189, -188, -187, -186, -185, -184
-183, -182, -181, -180, -179, -178, -177, -176
-175, -174, -173, -172, -171, -170, -169, -168
-167, -166, -165, -164, -163, -162, -161, -160
-159, -158, -157, -156, -155, -154, -153, -152
-151, -150, -149, -148, -147, -146, -145, -144
-143, -142, -141, -140, -139, -138, -137, -136
-135, -134, -133, -132, -131, -130, -129, -128
-127, -126, -125, -124, -123, -122, -121, -120
-119, -118, -117, -116, -115, -114, -113, -112
-111, -110, -109, -108, -107, -106, -105, -104
-103, -102, -101, -100, -99, -98, -97, -96
-95, -94, -93, -92, -91, -90, -89, -88
-87, -86, -85, -84, -83, -82, -81, -80
-79, -78, -77, -76, -75, -74, -73, -72
-71, -70, -69, -68, -67, -66, -65, -64
-63, -62, -61, -60, -59, -58, -57, -56
-55, -54, -53, -52, -51, -50, -49, -48
-47, -46, -45, -44, -43, -42, -41, -40
-39, -38, -37, -36, -35, -34, -33, -32
-31, -30, -29, -28, -27, -26, -25, -24
-23, -22, -21, -20, -19, -18, -17, -16
-15, -14, -13, -12, -11, -10, -9, -8
-7, -6, -5, -4, -3, -2, -1, 0
1, 2, 3, 4, 5, 6, 7, 8
9, 10, 11, 12, 13, 14, 15, 16

GMPLS UNI for Packet and Optical Integration
11

GMPLS UNI for Packet and Optical Integration
GMPLS UNI tunnel, RSVP, and LMP configuration commands and sample outputs



17, 18, 19, 20, 21, 22, 23, 24
25, 26, 27, 28, 29, 30, 31, 32
33, 34, 35, 36, 37, 38, 39, 40
41, 42, 43, 44, 45, 46, 47, 48
49, 50, 51, 52, 53, 54, 55, 56
57, 58, 59, 60, 61, 62, 63, 64
65, 66, 67, 68, 69, 70, 71, 72
73, 74, 75, 76, 77, 78, 79, 80
81, 82, 83, 84, 85, 86, 87, 88
89, 90, 91, 92, 93, 94, 95, 96
97, 98, 99, 100, 101, 102, 103, 104
105, 106, 107, 108, 109, 110, 111, 112
113, 114, 115, 116, 117, 118, 119, 120
121, 122, 123, 124, 125, 126, 127, 128
129, 130, 131, 132, 133, 134, 135, 136
137, 138, 139, 140, 141, 142, 143, 144
145, 146, 147, 148, 149, 150, 151, 152
153, 154, 155, 156, 157, 158, 159, 160
161, 162, 163, 164, 165, 166, 167, 168
169, 170, 171, 172, 173, 174, 175, 176
177, 178, 179, 180, 181, 182, 183, 184
185, 186, 187, 188, 189, 190, 191, 192
193, 194, 195, 196, 197, 198, 199, 200
201, 202, 203, 204, 205, 206, 207, 208
209, 210, 211, 212, 213, 214, 215, 216
217, 218, 219, 220, 221, 222, 223, 224
225, 226, 227, 228, 229, 230, 231, 232
233, 234, 235, 236, 237, 238, 239, 240
241, 242, 243, 244, 245, 246, 247, 248
249, 250, 251, 252, 253, 254, 255, 256
257, 258, 259, 260, 261, 262, 263, 264
265, 266, 267, 268, 269, 270, 271, 272
273, 274, 275, 276, 277, 278, 279, 280
281, 282, 283, 284, 285, 286, 287, 288
289, 290, 291, 292, 293, 294, 295, 296
297, 298, 299, 300, 301, 302, 303, 304
305, 306, 307, 308, 309, 310, 311, 312
313, 314, 315, 316, 317, 318, 319, 320
321, 322, 323, 324, 325, 326, 327, 328
329, 330, 331, 332, 333, 334, 335, 336
337, 338, 339, 340, 341, 342, 343, 344
345, 346, 347, 348, 349, 350, 351, 352
353, 354, 355, 356, 357, 358, 359, 360
361, 362, 363, 364, 365, 366, 367, 368
369, 370, 371, 372, 373, 374, 375, 376
377, 378, 379, 380, 381, 382, 383, 384
385, 386, 387, 388, 389, 390, 391, 392
393, 394, 395, 396, 397, 398, 399, 400
401, 402, 403, 404, 405, 406, 407, 408
409, 410, 411, 412, 413, 414, 415, 416
417, 418, 419, 420, 421, 422, 423, 424
425, 426, 427, 428, 429, 430, 431, 432
433, 434, 435, 436, 437, 438, 439, 440
441, 442, 443, 444, 445, 446, 447, 448
449, 450, 451, 452, 453, 454, 455, 456
457, 458, 459, 460, 461, 462, 463, 464
465, 466, 467, 468, 469, 470, 471, 472
473, 474, 475, 476, 477, 478, 479, 480

Controller SRLGs
None
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show mpls traffic-eng link-management optical-uni

Displays detailed GMPLS information of all the optics controllers. MPLS tunnels are not created when the
optics controller is in the shutdown state. The state is shown as "Admin down". Run the no shutdown command
under the optics controller to initiate the tunnel creation.
Mon Jul 1 20:00:42.108 IST

System Information:
Optical Links Count: 1 (Maximum Links Supported 100)

Optical interface: Optics0/0/0/0
Overview:
IM state: Up
Child interface: : IM state Unknown
OLM/LMP state: Up
Optical tunnel state: up

Connection:
Tunnel role: Tail
Tunnel-id: 15, LSP-id 3, Extended tunnel-id 10.105.57.100
Tunnel source: 10.105.57.100, destination: 11.1.1.1
Optical router-ids: Local: 10.105.57.101, Remote: 10.127.60.48
Label source: UNI-N
Upstream label:
Optical label:
Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number : -277

Downstream label:
Optical label:
Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number : -277

SRLG discovery: Disabled
SRLG announcement: None
Switching Type: lsc
MTU: 9212

Admission Control:
Upstream: Admitted (LSP ID: 3)
Downstream: Admitted (LSP ID: 3)

OLM/LMP adjacency information:
Adjacency status: Up
Local:
node ID: 10.105.57.101
link interface ID: 10
link ID: 11.1.1.1

Neighbor:
node ID: 10.127.60.48 (VEGA2K-Site-3_48)
link interface ID: 2130706976
link ID: 10.1.1.1
IPCC: Routed to 10.127.60.48

Optical capabilities:
Controller type: DWDM
Channel spacing: 6.25 GHz
Default channel: 0
784 supported channels:
-303, -302, -301, -300, -299, -298, -297, -296
-295, -294, -293, -292, -291, -290, -289, -288
-287, -286, -285, -284, -283, -282, -281, -280
-279, -278, -277, -276, -275, -274, -273, -272
-271, -270, -269, -268, -267, -266, -265, -264
-263, -262, -261, -260, -259, -258, -257, -256
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-255, -254, -253, -252, -251, -250, -249, -248
-247, -246, -245, -244, -243, -242, -241, -240
-239, -238, -237, -236, -235, -234, -233, -232
-231, -230, -229, -228, -227, -226, -225, -224
-223, -222, -221, -220, -219, -218, -217, -216
-215, -214, -213, -212, -211, -210, -209, -208
-207, -206, -205, -204, -203, -202, -201, -200
-199, -198, -197, -196, -195, -194, -193, -192
-191, -190, -189, -188, -187, -186, -185, -184
-183, -182, -181, -180, -179, -178, -177, -176
-175, -174, -173, -172, -171, -170, -169, -168
-167, -166, -165, -164, -163, -162, -161, -160
-159, -158, -157, -156, -155, -154, -153, -152
-151, -150, -149, -148, -147, -146, -145, -144
-143, -142, -141, -140, -139, -138, -137, -136
-135, -134, -133, -132, -131, -130, -129, -128
-127, -126, -125, -124, -123, -122, -121, -120
-119, -118, -117, -116, -115, -114, -113, -112
-111, -110, -109, -108, -107, -106, -105, -104
-103, -102, -101, -100, -99, -98, -97, -96
-95, -94, -93, -92, -91, -90, -89, -88
-87, -86, -85, -84, -83, -82, -81, -80
-79, -78, -77, -76, -75, -74, -73, -72
-71, -70, -69, -68, -67, -66, -65, -64
-63, -62, -61, -60, -59, -58, -57, -56
-55, -54, -53, -52, -51, -50, -49, -48
-47, -46, -45, -44, -43, -42, -41, -40
-39, -38, -37, -36, -35, -34, -33, -32
-31, -30, -29, -28, -27, -26, -25, -24
-23, -22, -21, -20, -19, -18, -17, -16
-15, -14, -13, -12, -11, -10, -9, -8
-7, -6, -5, -4, -3, -2, -1, 0
1, 2, 3, 4, 5, 6, 7, 8
9, 10, 11, 12, 13, 14, 15, 16
17, 18, 19, 20, 21, 22, 23, 24
25, 26, 27, 28, 29, 30, 31, 32
33, 34, 35, 36, 37, 38, 39, 40
41, 42, 43, 44, 45, 46, 47, 48
49, 50, 51, 52, 53, 54, 55, 56
57, 58, 59, 60, 61, 62, 63, 64
65, 66, 67, 68, 69, 70, 71, 72
73, 74, 75, 76, 77, 78, 79, 80
81, 82, 83, 84, 85, 86, 87, 88
89, 90, 91, 92, 93, 94, 95, 96
97, 98, 99, 100, 101, 102, 103, 104
105, 106, 107, 108, 109, 110, 111, 112
113, 114, 115, 116, 117, 118, 119, 120
121, 122, 123, 124, 125, 126, 127, 128
129, 130, 131, 132, 133, 134, 135, 136
137, 138, 139, 140, 141, 142, 143, 144
145, 146, 147, 148, 149, 150, 151, 152
153, 154, 155, 156, 157, 158, 159, 160
161, 162, 163, 164, 165, 166, 167, 168
169, 170, 171, 172, 173, 174, 175, 176
177, 178, 179, 180, 181, 182, 183, 184
185, 186, 187, 188, 189, 190, 191, 192
193, 194, 195, 196, 197, 198, 199, 200
201, 202, 203, 204, 205, 206, 207, 208
209, 210, 211, 212, 213, 214, 215, 216
217, 218, 219, 220, 221, 222, 223, 224
225, 226, 227, 228, 229, 230, 231, 232
233, 234, 235, 236, 237, 238, 239, 240
241, 242, 243, 244, 245, 246, 247, 248
249, 250, 251, 252, 253, 254, 255, 256
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257, 258, 259, 260, 261, 262, 263, 264
265, 266, 267, 268, 269, 270, 271, 272
273, 274, 275, 276, 277, 278, 279, 280
281, 282, 283, 284, 285, 286, 287, 288
289, 290, 291, 292, 293, 294, 295, 296
297, 298, 299, 300, 301, 302, 303, 304
305, 306, 307, 308, 309, 310, 311, 312
313, 314, 315, 316, 317, 318, 319, 320
321, 322, 323, 324, 325, 326, 327, 328
329, 330, 331, 332, 333, 334, 335, 336
337, 338, 339, 340, 341, 342, 343, 344
345, 346, 347, 348, 349, 350, 351, 352
353, 354, 355, 356, 357, 358, 359, 360
361, 362, 363, 364, 365, 366, 367, 368
369, 370, 371, 372, 373, 374, 375, 376
377, 378, 379, 380, 381, 382, 383, 384
385, 386, 387, 388, 389, 390, 391, 392
393, 394, 395, 396, 397, 398, 399, 400
401, 402, 403, 404, 405, 406, 407, 408
409, 410, 411, 412, 413, 414, 415, 416
417, 418, 419, 420, 421, 422, 423, 424
425, 426, 427, 428, 429, 430, 431, 432
433, 434, 435, 436, 437, 438, 439, 440
441, 442, 443, 444, 445, 446, 447, 448
449, 450, 451, 452, 453, 454, 455, 456
457, 458, 459, 460, 461, 462, 463, 464
465, 466, 467, 468, 469, 470, 471, 472
473, 474, 475, 476, 477, 478, 479, 480

Controller SRLGs
None

show mpls traffic-eng link-management optical-uni tabular

Displays detailed GMPLS information of all the optics controllers in tabular format.
Mon Jul 1 15:10:50.472 IST

System Information:
Optical Links Count: 4 (Maximum Links Supported 100)

State LMP GMPLS tunnel
Interface Admin Oper adjacency role tun-id state
--------------------------------------------------------------

Op0/0/0/0 up up up Tail 15 up
Op0/0/0/1 up up up Tail 16 up
Op0/1/0/0 up up up Tail 17 up
Op0/1/0/1 up up up Tail 18 up

show mpls traffic-eng tunnels

Displays information about tunnels.
Mon Jul 1 15:03:58.490 IST

LSP Tunnel 10.105.57.100 15 [5] is signalled, Signaling State: up
Tunnel Name: ckt0/0/0/0 Tunnel Role: Tail
Upstream label:
Optical label:
Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number : -277

Downstream label:
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Optical label:
Grid : DWDM
Channel spacing : 6.25 GHz
Identifier : 0
Channel Number : -277

Signalling Info:
Src 10.105.57.100 Dst 11.1.1.1, Tun ID 15, Tun Inst 5, Ext ID 10.105.57.100
Router-IDs: upstream 10.127.60.48

local 10.105.57.101
Priority: 7 7
SRLGs: not collected
Path Info:
Incoming Address: 10.1.1.1
Incoming:
Explicit Route:
No ERO

Route Exclusions:
No XRO

Record Route: Disabled
Tspec: avg rate=4294967033 kbits, burst=1000 bytes, peak rate=4294967033 kbits
Session Attributes: Local Prot: Not Set, Node Prot: Not Set, BW Prot: Not Set

Resv Info: None
Record Route: Disabled
Fspec: avg rate=4294967033 kbits, burst=1000 bytes, peak rate=4294967033 kbits

Displayed 0 (of 0) heads, 0 (of 0) midpoints, 1 (of 1) tails
Displayed 0 up, 0 down, 0 recovering, 0 recovered heads

show rsvp neighbors

Displays information about RSVP neighbors.
Mon Jul 1 14:58:48.888 IST
Global Neighbor: 10.127.60.48
Interface Neighbor Interface
-------------------- ------------
10.127.60.48 MgmtEth0/RP0/CPU0/0

show lmp gmpls optical-uni

Verifies the LMP configuration and state.
Mon Jul 1 14:55:35.492 IST

GMPLS Optical-UNI LMP Router ID: 10.105.57.101

LMP Neighbor
Name: ncs1k, IP: 10.127.60.48, Owner: GMPLS Optical-UNI
LMP: Disabled
IPCC ID: 1, State Up
LMP UDP port: 701
Known via : Configuration
Type : Routed
Destination IP : 10.127.60.48
Source IP : 10.105.57.101

Interface I/F | Lcl Interface ID | Lcl Link ID | Interface LMP state
----------------------+-------------------+----------------+-----------------------

Optics0/1/0/1 7 11.5.5.5 Up
Optics0/1/0/0 6 11.4.4.4 Up
Optics0/0/0/1 11 11.3.3.3 Up
Optics0/0/0/0 10 11.1.1.1 Up

GMPLS UNI for Packet and Optical Integration
16

GMPLS UNI for Packet and Optical Integration
GMPLS UNI tunnel, RSVP, and LMP configuration commands and sample outputs



GMPLS UNI tunnel troubleshooting commands and resolutions
Recommended show commands for troubleshooting GMPLS UNI tunnels

Collect and analyze the output of the following commands for any software issues on the GMPLSUNI tunnel.

• show tech-support mpls traffic-eng file filename

• show tech-support mpls rsvp file filename

• show lmp clients

• show rsvp neighbors

• show mpls traffic-eng link-management optical-uni controller optics Rack/Slot/Instance/Port

• show mpls traffic-eng tunnels tunnel-id

Table 2: GMPLS UNI tunnel issues and recommended resolutions

SolutionProblem

As a super user, collect and analyze the diagnostic
information by entering the following address in the
browser:

http://ip-address-of-head-node/diagnostics/wson

When the NCS 2000 node cannot route the Dense
Wavelength Division Multiplexing (DWDM)
wavelength to the destination, it displays a generic
error message: "No Route to destination".

Related information for GMPLS UNI
Refer to the following resources for additional information about GMPLS UNI.

• GMPLS UNI commands: Cisco IOS XR MPLS Command Reference.

• GMPLS Restoration and Reversion.
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http://www.cisco.com/c/en/us/td/docs/routers/crs/software/crs_r6-1/mpls/command/reference/b-mpls-cr-crs-61x/b-mpls-cr-53xcrs_chapter_0110.html
https://www.cisco.com/c/en/us/td/docs/optical/r11/ncs/network-config/b_ncs_network_configuration-R11/b_ncs_network_configuration_chapter_0100.html
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